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Guide

As a professionalMulti-track Blu-ray/DVD converter, Monstune helps to rip Blu-ray/DVD discs tomulti-trackMKV/MP4/MOV/AVI

without quality loss. Users are free to choose preferred subtitle(s) and audio track(s) including Dolby TrueHD audio track. Also designed



to 1:1 input to output convert Blu-ray/DVD to lossless mkv, the program allows users to retain all source original subtitles and audio

tracks without the need to decode and encode, saving users a lot of time and energy. It is able to rip and convert Blu-ray/DVD disc, folder,

ISO image file and other multi-track formats onWindows (10) with ease.

Guide Index

Part 1: Trial Version vs. Full Version

Monstune could rip and convert Blu-ray, DVD toMKVwithout quality loss andMKV/MP4/MOV/AVI with multiple subtitles and audio

tracks retained. It is available both in paid and trial version.

Trial Version Limitations:

Playing limit: There is a image watermark from Dimo that is added to your source Blu-ray/DVD for previewing with the trial

version. Ripping limit:For the trial version users, the length of converted video file from Blu-ray/DVD is limited. You can only convert

1/3rd of the disc with the trial version.

ISOMaking limit: Users can make ISO from Blu-ray with only 3 timeswith the trial version.

No technical support provided: For trial version users, no technical support is provided.

Full Version Benefits:

With full version of Monstune, you will enjoy the complete benefits include:

No playing limit: You can preview any Blu-ray/DVDwith no watermark limitation.

No ripping limit: You can rip any Blu-ray/DVDwith no length limitation.

No ISOMaking limit: There is no limit on the number of times that you can make ISO.

Complete technical support: You will get the complete technical support and upgrade fromDimo for lifetime.

Part 2: User-interface

Monstune: Get Started

https://www.mediadimo.com/images/monstune/guide/trial.jpg


Convert

Rip Blu-ray/DVD

Have some favorite Blu-ray/DVDmovies and want to play them on your iPhone, Android phone, VR, TV, etc.? It is a nice choice to

digitize Blu-ray/DVD to be supported by your device. Get video off a Blu-ray/DVD into digital format is quite easy throughMonstune!

Here we go:

Step 1: Launch Monstune

Download, install and openMonstune.

Step 2: Import Blu-ray/DVD to computer

The next step is to import inserted Blu-ray/DVD to computer from Blu-ray drive or DVD-ROM.

Step 3. Load Blu-ray/DVD to Software

To load DVDmovies, you can click "Add DVD" icon at the top of the interface. As for Blu-ray discs, please turn to "Add Blu-ray".

https://www.mediadimo.com/images/monstune/win/start.png
https://www.mediadimo.com/digitize-blu-ray.html
https://www.mediadimo.com/backup-dvd-game-of-thrones-to-digital.html
https://www.mediadimo.com/wp-content/uploads/2016/10/insert-dvd.png


Step 4: Set output video format

Look at the right panel of the software. Click "Select Format" to choose desired output video and audio format. You also can choose some

optimized preset from "Device > Apple" profile to get most compatible format for devices like iPhone X/8/8 Plus/7/7 Plus below.

https://www.mediadimo.com/images/monstune/win/bluray/mkv-format.png
https://www.mediadimo.com/iphone-supported-formats.html


Step 5: Edit Blu-ray/DVD (Optional)

You can edit Blu-ray/DVDmovies according to your need by clicking on "Edit" button. Then a new editing windowwill be opened from

where you can apply the required effects.

https://www.mediadimo.com/images/monstune/win/dvd/iphone-8-format.png


Step 6: Custom your own output video

To define a custom format, you can click on "Settings" button. This will open a new windowwhere you can choose your needed A/V

parameters and press "OK".

https://www.mediadimo.com/images/video/guide/trim.png


Step 7: Specify output folder

After all the above settings, the next step is to specify the output folder for the resultant file. You can either keep the default output

folder or specify another one according to your requirement by clicking "...".

Step 8: Start ripping Blu-ray/DVD to digital files

The last step is to hit on "Start" to begin to converting Blu-ray/DVDmovies to digital files you selected. The converting time relies on the

size of your source Blu-ray/DVDmovie.

Copy Blu-ray/DVD

Before ripping your Blu-ray or DVD discs, you can backup them at first.

For example, you can click "Copy Bluray Disc to Folder" copy Blu-ray disc to BDMV folder or click "Copy DVDDisc to Folder" to make

DVD backup to Video_ts folder.

https://www.mediadimo.com/images/monstune/win/dvd/iphone-8-settings.png
https://www.mediadimo.com/copy-bluray-bdmv-folder.html
https://www.mediadimo.com/copy-dvd-to-video-ts-folder.html
https://www.mediadimo.com/copy-dvd-to-video-ts-folder.html


Or copy Blu-ray/DVDmain titles by choosing "COPY TITLE" profile in Step 4.

https://www.mediadimo.com/images/monstune/win/bluray/bluray-to-folder.png
https://www.mediadimo.com/images/monstune/win/dvd/dvd-to-folder.png


Convert to SD/HD/4K videos

High definition video brings us more detailed, lifelike and impressed images.Want to turn your Blu-ray/DVD to SD/HD/4K video? You

can easily realize it withMonstune.

Step 1: Launch Monstune.

The very first step is to install Monstune on computer. Then double click on installation file to launch it.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD " button located on the top, it will open a file

explorer from where you can choose the disc name and confim for conversion.

https://www.mediadimo.com/images/monstune/win/bluray/copy-title.png


Step 3: Choose SD/HD/4K video as output format.

After imported source Blu-ray/DVD toMonstune, open "Select Format" drop-down list to locate "Video" or "HDVideo" category under

"Format" or "4K Video". You can choose any SD/HD/4K video format you want here.

https://www.mediadimo.com/images/monstune/win/bluray/hd-avi-format.png


Tip: By clicking "Settings" button, you can adjust the output video/audio resolution, frame rate, bit rate, etc. to customize the output files

to get the best quality you want.

Step 4: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files by clicking "...".

Step 5: Start conversion process.

Click "Start" button to start Blu-ray/DVD conversion process. It will take a fewminutes (depending on file size) for the conversion to

complete. Once the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert to Audio

https://www.mediadimo.com/images/monstune/win/bluray/hd-wmv-format.png
https://www.mediadimo.com/images/monstune/win/bluray/hd-wmv-settings.png


Want to extract your favorite music from a Blu-ray/DVD? You can never find a program that's so simple to use thanMonstune. Go ahead

by following the steps below:

Step 1: Launch Monstune.

First install and launch Monstune on your computer.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD " button located on the top, it will open a file

explorer from where you can choose disc name and confirm for conversion.

Step 3: Choose the output format under "Format > Audio" category.

After loading Blu-ray/DVD files into the program with success, specify your favorite output audio format for the output video. Hit "Select

Format" in the right panel of the program, in the pop out window, click "Format" tab, under "Audio" sub tab, select your desired audio

formats from the available audio file lists.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Tip: If the default video/parameters can't meet your needs, just click Settings icon to adjust the video codec, bitrate, frame rate, audio

sample rate, etc to get a decent video as you want. In principle, the larger input values, the better output quality, but the corresponding

larger file size.

Step 4: Specify output folder.

Once you have selected the output audio format, Then define an output folder on your computer to save the generated files. Leave

output folder to default if you don't want to change it to any other folder.

Step 5: Convert Blu-ray/DVD to audio.

Go back to the main interface, click on the "Start" button to start Blu-ray/DVD audio extracting process, it will take a few minutes

(depending on file size) for the conversion to complete.When the conversion is completed, click on "Open" button to view the generated

audio file. You can enjoy extracted audio files or make ringtone for iPhone/Android for listening to.

https://www.mediadimo.com/images/monstune/win/bluray/mp3-format.png
https://www.mediadimo.com/images/monstune/win/bluray/mp3-settings.png
https://www.mediadimo.com/halloween-ringtone-for-iphone.html


Convert toWebVideo

Sometimes, you maywant to share part of the scene of your loved Blu-ray/DVD discs with friends, family or the world. The best way is to

upload Blu-ray/DVD on video sharing sites like YouTube, Vimeo, Facebook, etc.. with YouTube/Vimeo/Facebook compatible format

usingMonstune with the steps below:

Step 1: Launch Monstune.

First install and launch Monstune on your computer.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD " button located on the top, it will open a file

explorer from where you can choose disc name and confirm for conversion.

Step 3: Edit video (Optional).

When the video is loaded into the program, click the "Edit" icon under the video output information panel, you can do some simple and

basic video editing work such as trimming, croping, adding text watermark, deinterlacing, adding special effect, etc. according to your

own needs. This step is optional and can be skipped if you do not need this step.

https://www.mediadimo.com/youtube-format.html
https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Step 4: Choose the output format.

Once you have completed the Blu-ray/DVD video editing process, choose the outputWeb video format in the "Web" profile under

"Format" from "Select Format" section. There are multiple different online websites for you to choose from.

https://www.mediadimo.com/images/video/guide/crop.png


Step 5: Define your own output video

If you could not find your desired output format from the output formats list, you can create your own custom format by clicking on

"Settings" button as highlighted below. In the "Settings" window, choose the video/audio settings according to your requirement and

then click "OK".

https://www.mediadimo.com/images/monstune/win/bluray/youtube-format.png


Step 6: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files by clicking "...".

Step 7: Start the conversion process.

Click on "Start" button to start the Blu-ray/DVD toWeb formats conversion process, it will take a fewminutes (depending on file size) to

complete.When the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert to Editors

At present, most video editting software like Sony Vegas, Adobe Premiere Pro,WindowsMovieMaker, etc. can't allow you to edit

Blu-ray/DVDmovies before publishing or sharing with your friends. So, in this case, You can convert Blu-ray/DVD to editable format

withMonstune with the steps below before importing and editing:

Step 1: Launch Monstune.

First install and launch Monstune on your computer.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD " button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

https://www.mediadimo.com/images/monstune/win/bluray/youtube-settings.png


Step 3: Edit video(Optional).

When the Blu-ray/DVD video is loaded into the program, click the "Edit" icon under the video output information panel, you can do some

simple and basic video editing work such as trimming, croping, adding text watermark, deinterlacing, adding special effect, etc according

to your own needs. This step is optional and can be skipped if you do not need this step.

Step 4: Choose the output format.

Once you have completed the video editing process, choose the output Editor video format in the "Editor" profile from "Select Format"

section. There are multiple different video formats for you to choose from.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png
https://www.mediadimo.com/images/video/guide/watermark.png


Step 5: Define your own output video

If you could not find your desired output format from the output formats list, you can create your own custom format by clicking on

"Settings" button as highlighted below. In the "Settings" window, choose the video/audio settings according to your requirement and

then click "OK".

https://www.mediadimo.com/images/monstune/win/bluray/premiere-pro-format.png


Step 6: Specify output folder.

After all the settings is completed, define an output folder on your computer to save the generated files.

Step 7: Start the conversion process.

Click on "Start" button to start the Blu-ray/DVD to editor conversion process, it will take a fewminutes (depending on file size) to

complete.When the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert toMulti-track

You can rip Blu-ray/DVD to lossless mkvwith the same codec as the original one in fast mode, and also output multi-track

MP4/MKV/AVI/MOVwithMonstune with the steps below:

Step 1: Launch Monstune.

First install and launch Monstune on your computer.

Step 2: Add Blu-ray/DVD to be converted.

https://www.mediadimo.com/images/monstune/win/bluray/premiere-pro-settings.png
https://www.mediadimo.com/lossless-blu-ray-to-mkv-backup.html
https://www.mediadimo.com/copy-dvd-to-lossless-mkv.html


Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

Tip: You can edit loaded Blu-ray/DVD video files via the internal video editor by clicking "Edit" before conversion.

Step 3: Choose the output format.

Choose the output format in the right panel for your video, here you need to choose Lossless MKV orMulti-trackMP4/AVI/MOV/MKV

from "Format >Multi-track" to keep all original audio channels/subtitles or retain selected audio tracks or subtitles.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Note: The "fast mode" option is checked by default now if you select lossless mkv format. And you don't need to do any format settings

since fast mode is activated when remuxing your Blu-ray/DVD videos. For multi-track formats, you can click "Settings" and choose

preferred multiple audio tracks or subtitles for preserving.

https://www.mediadimo.com/images/monstune/win/bluray/lossless-mkv-format.png


Step 4: Specify output folder.

Define an output folder on your computer to save the generated files.

Step 5: Start the conversion process.

Click on "Start" button to start the Blu-ray/DVD conversion process, it will take a fewminutes (depending on file size) for the conversion

to complete. When the conversion is completed, click on "Open" or "Open Folder" button to view the generated video file.

Convert to Apple/Samsung/LG/Android

Want to enrich your newly purchased iPhone, iPad, iPod, Samsung, LG, Android, etc. with all your favorite Blu-ray/DVD collections for

watching on the move?While, it is really a great headache that your mobile devices can only playback just few format files. Don't worry.

WithMonstune, you can easily get Blu-ray/DVD video to be played on the move with the optimal profile settings.

Step 1: Download, install and launchMonstune.

Double click installation file on your computer to launch it.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

https://www.mediadimo.com/images/monstune/win/bluray/lossless-mkv-subtitle-settings.png


Step 3: Select the desired output format from the "Device" option.

To make the output video to be compatible with your Apple/Samsung/LG/Android, hit "Select Format" in the right panel, in the pop out

window, click "Device" tab, choose "Apple", "Samsung", "LG", "Android", "Sony", "HTC", etc. in the sub tab, then you will be able you select

your specific device model from the available devices list.

Tip: If the default settings do not fit you requirement, you can click "Settings" icon to adjust video size, bit rate, frame rate, sample rate

and audio channels.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png
https://www.mediadimo.com/images/monstune/win/bluray/android-phone-format.png


Step 4: Choose output folder.

After you have chosen your device from the "Select Format" list, the next step is to find a location to store the converted files. You can

select the output folder according to your own preference.

Step 5: Start to convert Blu-ray/DVD to Apple/Samsung/LG/Android.

After above settings is done, hit right-bottom "Start" button to start converting loaded Blu-ray/DVD to device optimized file formats. The

conversion time will be highly dependent on the file size of the video file.

Step 6: Transfer Video to devices.

When the conversion is complete, you can find the generated video file in output folder specified. Connect your mobile phone to your

computer and then transfer the video file to iPhone/iPad via iTunes, or share to Android either through USB orWi-Fi.

Convert to TVs

https://www.mediadimo.com/images/monstune/win/bluray/android-phone-settings.png
https://www.mediadimo.com/transfer-videos-to-iphone.html
https://www.mediadimo.com/transfer-video-to-android.html


Nowadays it is convenient to put movies on USB flash drive and play them on your TV via USB port. What happens is that the TV can't

read the Blu-ray/DVD video files. Fortunately, withMonstune, you can easily get TV compatible file format from source Blu-ray/DVD

disc/folder/ISO files.

Step 1: Launch Monstune.

Double clickMonstune icon on your computer to launch it.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD " button located on the top, it will open a file

explorer from where you can choose the disc name for conversion.

Step 3: Select TV preset format under the "TV" option.

To make the output video to be compatible with your Panasonic/Samsung/Sony/LG TV, hit "Select Format" in the right panel, in the pop

out window, click "Device" tab and choose formats under "TV" option.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Tip: Click the "Settings" button and customize proper video/audio parameters if necessary. Video size, bitrate and fame rate are flexible

and can be adjusted as you like.

https://www.mediadimo.com/images/monstune/win/bluray/samsung-tv-format.png


Step 4: Choose output folder.

After you have set the output format for TV, the next step is to find a location to store the converted files. You can select the output

folder according to your own preference.

Step 5: Start to convert Blu-ray/DVD to Panasonic/Samsung/Sony/LG TV.

After above settings is done, hit "Start" button to start converting loaded Blu-ray/DVD files to TV optimized file formats. The conversion

timewill be highly dependent on the file size of the Blu-ray/DVD video file. When the conversion is complete, you can find the generated

video file in the output folder specified. And you can transfer all the output files to a USB drive and then play them on TV either through

USB orWi-Fi.

Convert to GameConsoles

We can use Xbox 360, XboxOne (S), PS3, PS4 (Pro), PS Vita, PSP,Wii, etc. to stream all TV shows andmovies for playback on living room,

but our next concern is: Blu-ray/DVD support with these game consoles. For playing Blu-rays/DVDs on game consoles smoothly, it is

suggested to convert them to playable media formats by Xbox/Playstation/Wii/PSP. ThenMonstune can be the best assistant to convert

Blu-ray/DVD to game consoles formats onWindows (10/8.1/8/7/XP) in a few clicks as below.

Step 1: Launch Monstune

First of all you need to launch theMonstune on your system.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

https://www.mediadimo.com/images/monstune/win/bluray/samsung-tv-settings.png
https://www.mediadimo.com/free-play-game-of-thrones-on-tv.html


Step 3. Select the Output File Format and destination folder

Next task is to select the Output file format and it must be adjusted as per your Game console requirement. Select your model from

"Games". Then click "..." to browse your computer for a better destination folder for game console video converter to save your

converted movies.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Tips: The default setting works well. Of course, if you want to customize video and audio encoding settings, just click the "Settings"

button to customize these settings. You can adjust the output video/audio resolution, frame rate, bit rate, etc. to customize the output

files to get the best quality you want.

https://www.mediadimo.com/images/monstune/win/bluray/ps4-pro-format.png


Step 4: Start conversion

Once you've selected the output file format you want, you're ready to hit the "Start" option and within few seconds you new customized

video will be available on your preferred folder. Wait for the conversion to be done and click Open to get the converted video files. Now

start to stream converted files to Xbox 360, Xbox One (S), PS3, PS4 (Pro), PS Vita, PSP,Wii, etc. flawless and easily watch the high

definition movie on your TV via DLNA server.

Convert to VR headsets

Converting your Blu-ray/DVD into 3D/VR video is muchmore fun than it sounds! And it is possible to do this job for VR headset like Gear

VR, HTCVive, Oculus Rift, PSVR, etc. with their friendly format within minutes using Monstune. Please follow the steps below to

understand how to convert Blu-ray/DVD video file to customized formats for VR headsets:

Step 1: Launch Monstune

The first step is to launchMonstune by double clicking the installation file.

https://www.mediadimo.com/images/monstune/win/bluray/ps4-pro-settings.png
https://www.mediadimo.com/watch-movies-on-vr-headsets.html


Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

Step 3: Set 3Dmode

If you are thinking to create 3D effect for VR glasses or design a customized vide, thenMonstune can assist you better with its advanced

video editing tools. You simply need to click on the "Edit" button and a new window with all tools available for editing will soon appear.

This software provides Side-by-Side (Left-right) outputs, Top bottom and Anaglyph 3D (Red-blue) mode for you to choose from "3D" tab.

Perform required actions and save the video by hitting OK button.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


Step 4: Choose the output format from "VR" category

Once you have loaded the Blu-ray/DVD file inMonstune, you need to choose the relevant output format. To convert a Blu-ray/DVD to

VR headsets, choose your device type from options from the "VR" tab under the "Select Format" tab. There are a number of VR headsets

available like Gear VR, HTC Vive, Oculus Rift, PSVR, etc.

https://www.mediadimo.com/images/video/guide/3d.png
https://www.mediadimo.com/play-3d-mkv-on-ps-vr.html


Tip: If you like, you can go to "Settings" page to adjust the parameters including video size, bitrate, frame rate, etc.

https://www.mediadimo.com/images/monstune/win/bluray/psvr-format.png


Step 5: Specify the output folder

Once you have specified the output format, you can also change the default output folder for the resultant file.

Step 5: Start converting the Blu-ray/DVD video to VR headsets

Once you havemade all the settings, the final step is to actually convert the loaded Blu-ray/DVD into 3D or VR videos. Click on the

"Start" button to start the conversion process. Once the conversion process is complete, the resultant video file is a 3D video file

for transferring to Gear VR, HTC Vive, Oculus Rift, PSVR, etc. for watching.

Convert to GIF

Step 1: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion. You could playback loaded Blu-ray/DVDmedia files by

clicking with the built-in player.

https://www.mediadimo.com/images/monstune/win/bluray/psvr-settings.png
https://www.mediadimo.com/watch-movies-on-vr-headsets.html


Step 2. Editing the video

Click "Edit" to activate build-in video editor, then go to "Trim" to simply select the start and end times in the progressing bar bymoving

the points and click "+" to cut the video and press "OK".

Tip 1: If you think the video containting the embrassing background, then you could click "Adjust" > "Crop" to locate your specific portion

of your video in output .gif file.

https://www.mediadimo.com/wp-content/uploads/2017/03/trim-video-make-gif.jpg


Tip 2: Click "Effect", you can apply some color effects like de-interace etc; And "Watermark" to input text you like to show.

Step 3. Choose Output GIF Format

Open the drop-down box right and then click the "Select Format " bar to enter the "Profile" panel, where you could select a proper profile

as output format. You could select "GIF" from "Format > Video".

https://www.mediadimo.com/wp-content/uploads/2017/03/crop-video-make-gif.jpg


Ormake use of the profile search bar to search desired profile quickly.

Step 4. Set Video and Audio Parameters

You could hit the setting gear icon to enter the "Profile Settings" interface to adjust video and audio parameters of selected output

profile, including: Video Codec, Quality, Video Size, Bit Rate, Frame Rate, Aspect Ratio as well as Audio Codec, Quality, Bit Rate, Sample

Rate, Channels, etc.

https://www.mediadimo.com/images/monstune/win/bluray/gif-format.png
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Tip: Here you can optimize the frame rate because your computer may not be able to run everything smoothly at a higher frame rate.

Most videos are shot at either 30 or 60 fps, but GIFs are meant to be quicker, smaller, and a little jerky looking. The basic principle here is

that, the smaller the framerate, the faster the GIF will take to play and load. 10-15 FPS is usually perfect.

Step 5. Start making GIF from Blu-ray/DVD

Set a directory to save the output video/audio files by clicking "...". Then Click on "Start" button to start converting Blu-ray/DVD video

files to GIF within this GIFmaker software. Now your created .gif file from video is ready to be used for uploading to Instagram, Imgur,

Minus, Dropbox, or any other file hosting service you prefer, or social media posts etc.

Edit

Trim Blu-ray/DVD

Want to trim out a funny part of a Blu-ray/DVD? Or just cut out the shaky or useless parts of a Blu-ray/DVD to save space on your hard

drive?WithMonstune, you can easily trim Blu-ray/DVD video to get your desired parts by following the steps below.

Step 1: Launch Monstune.

First install and launch Monstune on your computer.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.
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Step 3: Click the "Edit" option to open "Video Editor" window.

After the files are successfully loaded in the program, hit the "Edit" icon to open a new video editing window.

Step 4: Trim video to get desired parts.

In the opened video editing window, click the "Trim" tab, under the trim tab, drag the slider bar on the "start" line to set the start

trimming point, move the slider bar on the "end" line to set the ending time point, then click "Add TrimMarker" button to add this

segment for trimming.

https://www.mediadimo.com/images/monstune/win/bluray/mp4-format.png


If you need to trim multiple segments, choose another trim start time and end time, then use "Add TrimMarker" button again. You can

modify the start time and the end time according. If any point of time, you are not happy with the trimming, you can use the delete button

and set the trimming start point again. If you like to put these trimming segments in right order, click "Up" or "Down" button to do

adjustment. To add this multiple trimming segments into one file, check "Merge" option, otherwise you will get splitted trimming files.

Step 5: Define output file format.

On the main interface, click "Select Format" section on the right panel, in the pop out window, select your desired output format for the

trimmed video.

Step 6: Choose output folder.

Specify a destination folder on your computer to save the trimmed videos. You can also choose to skip this step if you want to save the

generated file in the default location.

Step 7: Start the conversion process.

Click on the "Start" button to start the Blu-ray/DVD conversion process, it will take a fewminutes (depending on file size) for the

conversion to complete.
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Vignette Blu-ray/DVD

Perhaps, you never thought that you can vignette a Blu-ray/DVD video on your own. But, now you can easily get it done using Monstune

by following the steps below:

Step 1: Launch Monstune

Simply launchMonstune by double clicking the installation file.

Step 2: Add Blu-ray/DVD to be converted.

Now, it is time to add Blu-ray/DVD you want to convert. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for conversion.

Step 3: Click on "Edit" button

To vignette a video, you should start editing the video file. To edit the loaded video file, click on the "Edit" button at the bottom of the

output box. Clicking on edit button will open a new editing window.

Step 4: Click on "Effect" tab

In the new editing window, choose the "Effect" tab which will show you a number of editing options.

Step 5: Choose "Vignette" feature

Pull down the function choices and find the "Vignette" feature. Hit it on. Or you can choose other effects to tune up your video.
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Step 6: Choose the output format

You can ignore it if you don't need to change your video format. The next step is to choose the output format of the resultant video. You

can choose the output format from the right pane in the "Select Format" tab. All the formats supported byMonstune are available here.

Step 7: Specify the output folder

When you have chosen the output format, you can specify the destination folder for the resultant video file. If you don't specify a folder

here, the resultant video file will be stored at the default location specified byMonstune.

Step 8: Start to vignette a video

Go back to the UI no matter you changed or didn't change the output format. As soon as you click on the "Start" button, the video

vignette process starts.

Crop Blu-ray/DVD

If needed, you can useMonstune to crop your Blu-ray/DVD video tomake it more fit in the screen of your devices so that you can get

higher entertainment. Please follow the steps below to crop your Blu-ray/DVD video:

Step 1: Launch Monstune

The very first step is to launchMonstune by double clicking the installation file.

Step 2: Add Blu-ray/DVD to be cropped.

Now, it is time to add Blu-ray/DVD you want to crop. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm for cropping.
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Step 3: Start to crop video

Click on the "Edit" button to open a new editing window that contains a number of editing features. From the new editing window, click

on the "Adjust" tab to open another array of editing options.

The above four icon are used for flipping the video in various angles and rotate your source files. To make the display effect better fitted,

you can choose "Keep Aspect", "Full Screen", "16:9" or "4:3", then use the "Crop" button to adjust the crop frame. Or you can check the

box to activate to adjusting Contrast, Saturation, Brightness, etc and directly drag the progress bar to get the effect you need. And you

can preview the original and modified video in the preview area in real time. Then click "Apply to All" to apply this settings to other added

videos befor conversion.
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Step 4: Choose the output format

If you want another video format from the video croping process, just choose a new video format from "Select Format" profile. All the

formats supported byMonstune are listed here.

Step 5: Specify the output folder

Dimo has a default folder to save your generated files. Of you also can change the output folder according to your requirement. Select

your defined output folder. Apparently, the output folder is the one where the resultant converted file will be stored. And you can specify

any other folder according to your wish here.

Step 6: Start to convert

The last step is to perform the actual conversion. Click on the "Start" button to actually start converting the Blu-ray/DVD video. The

duration of conversion will be highly dependent on the size of the video file needing to be crop.

Add TextWatermark
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Adding text watermark to a Blu-ray/DVD tomark the video belonging to you. Monstune can help you apply a text watermark to the

Blu-ray/DVD video easily and quickly. Please follow the steps below to add text watermark to any Blu-ray/DVD video:

Step 1: Launch theMonstune

Download, install and openMonstune by double clicking the installation file.

Step 2: Add Blu-ray/DVD

Now, it is time to add Blu-ray/DVD you want to add watermark. You can "Add Blu-ray" or "Add DVD" button located on the top, it will

open a file explorer from where you can choose disc name and confirm for adding watermark.

Step 3: Click on "Edit" button to start editing

Select the "Edit" button option under the output box. Once you click on the edit button, a new windowwill pop up containing a number of

features available.

Step 4: Click on "Watermark" tab to add text watermark

In the video editing window, click "Watermark" icon under the video screen where you can add a textual watermark. Just tap the text

what youwant to add into the video in the right place. Click "Apply" and you can choose font size and and adjust the horizontal and

vertical position of the text watermark. After all the settings, click "OK".
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Step 5: Choose the output format

You can ignore the step unless you would like to change the original video format. Go back to the UI, in the right pane, find the "Select

Format" section. Monstune offers a number of video, audio and device format. Choose any one you want.

Step 6: Specify the output folder

Generally, Monstune is output folder set. But you can change the default location to choose a new folder to store your generated files

with text watermark.

Step 7: Start the conversion process

When you havemade all the settings, the last step is to actually start the Blu-ray/DVD conversion process by clicking on the "Start"

button.

Apply 3D Effect

You can apply 3D effect like "Red-Blue, Left-Right, Top-Bottom" in the 3D tab to make 2D/3DBlu-ray or 2DDVD to 3Dmovie

conversion.

Step 2: Add Blu-ray/DVD

Now, it is time to add Blu-ray/DVD you want tomake 3D. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a

file explorer fromwhere you can choose the disc name and confirm for 3D creating.
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Step 2. Select output format

Click "Select Format" bar and find "Format > Video", there are a lot of format options for you. Here MP4 is recommended for most 3D

players, 3D devices, VR headsets. The new profiles for VR headsets like HTCVive, Gear VR, Oculus Rift, PS VR are ready for you.

Step 3. Advanced Video/Audio settings

Click "Settings" button to do corresponding settings regarding to video, audio.

Step 4. Add 3D effect

Click "Edit" icon, turn to "3D" tab, and choose Left-Right option to add side-by-side effect to your 3Dmovies. Or you can choose

Top-bottom or Red-blue 3Dmode.
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Step 5. Start to convert movies to 3D

The last step is to press the "Start" button on the right to start converting Blu-ray/DVDmovies to 3D vidoes. The conversion takes a few

minutes, after conversion, you can click "Open" to locate the output videos for transferring.

Apart from the above editing functions, you can take snapshot of your favourite videos as .jpg file to save the shinning moment for

reviewing.

Burn

Make ISO

Monstune allows the users tomake ISO from Blu-ray folder directly. Please follow the steps below to create ISO using Monstune:

Step 1: Launch Dimo and add Blu-ray

LaunchMonstune and click "Make ISO" to locate your source Blu-ray folder.
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Step 2: Start making ISO

Click on the "Start" button to start the Blu-ray to ISO backing up to ISO converting process. It will take a fewminutes to complete the

process.

Compress

Compress Blu-ray/DVD

Your portable devices can't hold so many movies for your viewing at a time unless you compress the Blu-ray/DVD video to smaller size.

WithMonstune, you can easily compress Blu-ray/DVD video:

Step 1: Launch Monstune

Double click onMonstune icon on PC to launch the software.

Step 2: Load Source Blu-ray/DVD

After openedMonstune, you need to import your the video file from DVD/Blu-ray, then "Add DVD" or "Add Blu-ray" option must be

used.
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Step 3: Choose Output Format

You can change your source video format by choosing another output video format. Find "Select Format" function on the right of the

interface to choose any output format offered byMonstune.
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Step 4: Compress Video Size

Generally, to compress a Blu-ray/DVD video size, you can downscale its resolution or decrease video bitrate. After you chose output

format, you can hit on "Settings" to open a newwindow. Here, you can reset video size and bitrate to decrease the original file size.
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Note: After settings, you can look at the file size the converter estimates for you. And if it gets over your requirement, lower the video

quality setting: Bitrate and Sizewhich greatly decide the output file size.
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Step 5: Specify the output folder

By default, Monstune allots certain folder for saving all the generated files. Of course, you are allowed to reset the output folder.

Step 6: Start to compress Blu-ray/DVD video

When all the settings are done, you can start the Blu-ray/DVD video compression process by clicking on the "Start" button located at the

middle of the screen.

Play

Play Blu-ray/DVD

Monstune can enable you to play any Blu-ray/DVD video files regradless of its protection and region code. Please follow the steps below

to play Blu-ray/DVD throughMonstune:

Step 1: Launch Monstune

Download and install Monstune. Then launchMonstune by double clicking the installation file.

Step 2: Add Blu-ray/DVD

Now, it is time to add Blu-ray/DVD you want to play. You can "Add Blu-ray" or "Add DVD" button located on the top, it will open a file

explorer from where you can choose the disc name and confirm.
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Step 3: Start to Play Blu-ray/DVDVideo

After you loaded the Blu-ray/DVD video intoMonstune, you can see themovie list on the interface. Move the mouse on the thumbnail

and click it, a media player will pop up and you can play your video now.

Step 3: Start to Play Blu-ray/DVDVideo

After you loaded the Blu-ray/DVD video intoMonstune, you can see themovie list on the interface. Move the mouse on the thumbnail

and click it, a media player will pop up and you can play your video now.
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Share

Share Ripped Blu-ray/DVDwirelessly

Monstune has a outstanding advantage. That is you can cast the converted or ripped video from Blu-ray/DVD to your iPhone, iPad,

Android Tablet/Phone, TV by the "Media Server" feature offered byMonstune.

Step 1: Keep your device and PC in same network

Firstly, you need to keep your portable devices and the PC running the software on in the same network.

Step 2: OpenMonstune

The second step is to launch Monstune.

Step 3: Choose "Media Server" and locate source files
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Click on "Media Server" icon at the top of the interface and choose the source media folder to locate by pressing "Browse...". Then hit

“Share”. Your IP and Port will be detected automatically, and you will get a QR code.

Step 4: Scan the resulted OR code for sharing

Use your iPhone, iPad, Android phone/tablet to scan the QR code then you can play the video directly by clicking it from the playlist

without needing to transfer the media to devices via USB. For TV users, you can write http://IP:PORT like "http://192.168.1.109:8868/"

(without quotation marks) to the address bar of your browser for sharing your media files.

Then loaded video source will be listed and you can now play local files or converted movies on mobile devices or TV at your will.
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